[bookmark: _r5byueh5r7h6]QGIS Draw My CA Plugin User Guide
Please refer to the ‘QGIS Software and Plugin Installation’ document for instructions on how to install the plugin. This guide describes how to create a new project, use the redistricting tool panel, and navigate the various other tools and features found within the Draw My CA plugin.

Note: You can turn off the plugin at any time by opening Plugins → Manage and Install Plugins. There you can uncheck the box next to “swdbqgis” or you can uninstall the plugin entirely. 

[bookmark: _64zaabw12dcz]Creating a New Project
[bookmark: _1maek3bas8bv]Plan Management
Once you have logged in, you can create a new project or select a previous project to work on through the Plan Management dropdown menu. This window should open automatically after logging in.
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[bookmark: _a0hsuggmo3qm]Create a new project	
Select “New Project” from the project dropdown menu. Then title your project in the “Project Name” box, and check/uncheck the Counties on which you want to be added to your project. If you choose to make a project that includes many counties or the entire state, note that it may take a few minutes to open. Once you have selected the counties you are working with for this given project, we do not recommend going back and changing these as it may cause errors in your project. If you would like to adjust the area you are working in, we recommend you make a new project with the appropriate counties.
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In the case that you close the Plan Management window, you can regain access by clicking the plugin’s dropdown, “Draw My CA”, at the toolbar at the top of QGIS. Then, Plan Management again.
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Please also note that we suggest you make all new projects through these described steps (Plan Management → New Project) and not through the built-in QGIS method (Project → New Project). 

[bookmark: _icviuvgrgs95]Work on a Previous Project
The projects available in the dropdown menu will depend on if you selected an Offline or Connect session. Once you select the project that you want to work on, press open. While you are able to add/remove counties from the project which you are opening, we do not recommend you to do this as this may alter the project. 
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[bookmark: _6s2w86nm0lpa]Plan Layer Management
[bookmark: _riprb5tpy14a]Create a Plan Layer
The Plan Layer Management menu is where you will create your different district(s) and plans for the county/counties you have chosen to work in. All users must create one layer to start and can choose to add more later, depending on if you would like to create districts in new plan types.
[bookmark: _b3s6558vn94a]Create Layer
To create a layer, type a name into the “Layer Name” input box. Select a plan type from the Plan Type drop down menu: California State Senate, California State Assembly,  Board of Equalization, or US House of Representatives. If you would like to start with the current districts (created from the 2011 Redistricting process), you can choose this from the “Start with existing Layer” drop down menu. You can also start with a previous layer you created in this same drop down menu. If you would like to start fresh, do not alter the “start with existing Layer” drop down menu. 
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In the case that you cancel the Plan Layers window, you can regain access by clicking the “Draw My Ca” plugin and Selecting Plan Layer Management again.
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[bookmark: _vjjfn6lbmr29]

[bookmark: _tod7sgl67gjc]Delete Layer
Users can also select layers they want to delete from the Plan Layer Management drop down menu in the ‘Delete Layer’ tab.
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[bookmark: _eedv3nzgkx4h]Redistricting
This section accounts for the majority of the guide, as it details how to use the plugin’s redistricting tool. Creating a layer under Plan Layer Management will automatically open the Redistricting Panel in the bottom left corner of QGIS. Selecting “Redistricting” from the “Draw My CA” plugin opens the Redistricting Panel on its own.
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[bookmark: _6998hf4d99yi]Redistricting Panel
[bookmark: _8yr7wmfq2gfx]Redistricting Layer
Select which layer you would like to make edits on from the drop down menu.
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[bookmark: _84he5xqko6up]Geography
Select which level of Census geography you would like to make edits using from the drop down menu. This can be changed at any time. 
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[bookmark: _e0maobgq5u7h]Action
Select which action you would like to take in editing - “Add area,” “remove area”, or “New District.” 
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[bookmark: _4yfy0wyn5q4y]

[bookmark: _e11pn1lsstbg]Redistricting Icons
[bookmark: _nj7mnavk6ghe]Select District
Press this button and click anywhere on the map to choose which district you want to work in. The district will be shaded in on the map and highlighted on the list in the Redistricting panel. You must also select a district you would like to add or remove an area in, either from the list of districts in the Redistricting panel or through the “Select District” icon and clicking on the map.
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[bookmark: _uzkgmmj6pm54]Select Features by Area of Single Click
Choose what method of selection you would like to use in your edits from the drop down menu.
1. Select Feature(s): Click and drag across an area on the map to select by rectangle, or simply single click to select one feature. 
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2. Select Features by Polygon: Create a polygon shape which you want to select by single-clicking the corners of your desired polygon shape. Right click when you are done drawing your polygon shape. 
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3. Select Features by Freehand: Single click where you would like to start, and then draw a freehand shape which would like to start. Right click when you are done drawing your desired shape. 
[image: ]

4. Select Features by Radius: Single click and move your mouse to determine the radius length of a circle which would you like to select. You can also manually enter the radius of your selection in the top right corner of the map. Right click when you are done drawing your desired shape. 
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5. Select Features by Geography: Choose which Layer you would like to add/remove area from the list that appears in the bottom of the Redistricting Panel. Then single click on the map in the desired area.
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6. Deselect Features from All Areas: This will deselect any area that is currently highlighted in all areas.
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[bookmark: _31wsvnxffry]Add Area to District
Once you have selected your desired area, it will be highlighted on the map. You can add the selected area to the district by clicking on the desired district in the Redistricting Pannel and then clicking the green plus icon (equivalent keyboard shortcuts are “alt +” and “alt -”). 

[image: ]
[bookmark: _57k1ejh785ju]Move through the District List
You can move through the list of districts by using the up and down arrow icons in the redistricting panel, or through the arrow keys on your keyboard. The map will recenter the map to the district you have selected in the list and will shade the selected district on the map.
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[bookmark: _n4pbnqif12u4]Lock District
Once you are satisfied with the boundaries of one district, you can lock the district through clicking the orange closed lock icon on the Redistricting Panel. Locking a district will prevent any future edits to selections from the locked area. You can unlock the district at any time by clicking the Lock icon again. This may also be useful if you are editing an adjacent district and do not want to alter the others around it.  In the “Locked” column of the redistricting panel you can see which districts are currently locked or unlocked. 
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[bookmark: _pni5chfmiml3]Show Statistics
The “show statistics” icon appears as a green spreadsheet and will close or open the statistics panel in the bottom right of the screen. 
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[bookmark: _o7uui3xikkpt]
[bookmark: _2gafjvkz8z29]
[bookmark: _697rm0g53qf3]
[bookmark: _bvmlubp29ijc]

[bookmark: _kpe29k3h2vp2]Change District Attributes
If you would like to change the title of the district or add comments about the district, you can do so by clicking the “Change District Attributes” icon that appears as a blue piece of paper with a yellow pencil in the right bottom corner. To update the title, type into the top input box. The updated District Title will show up in the District Name column of the Redistricting Panel and on the layers panel. To add comments, type into the larger input box below (250 is the maximum characters allowed for these comments).
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[bookmark: _idimtran37bo]Delete District
The icon that appears as a red square with a white “X” inside is the Delete District button. If you would like to permanently remove a district, select the desired district in the list in the Redistricting panel and click this icon. It will remove the district from the list and the area that was once assigned to it will now be unassigned on the map. 
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[bookmark: _aaj7dnw9y3tv]
[bookmark: _r6esq1l1p6s2]
[bookmark: _176ljp86w5yn]

[bookmark: _9kpvta23dsgo]
[bookmark: _sirz76l9jsw3]Undo/Redo 
To undo or redo the most recent changes you made on the map, you can do so by clicking the green arrow icon pointing to the left (undo) and the green arrow icon pointing to the right (redo). 
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[bookmark: _w275juups0uw]Statistics Panel
This panel displays the statistical information about the district in the layer which you are working. You can change what parameters are shown in the statistics panel through the drop down menu in the top left corner of the panel. 
· The “Parameter” column lists the title of the different parameters available 
· The “Current Value” column lists the current value of each parameter. 
· The “selected Area Value” column lists the value of the parameter for the area that is currently selected on the map. 
· The “Proposed Value” lists the value of the parameter if the selected area value was added to the current value.  
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[bookmark: _6xcqjfgfjwr8]Additional Plugin Features
[bookmark: _rkk3mm6abh4w]Plan Import
Users can create their own plan layers through modifying an existing layer or importing an equivalency file. 
[bookmark: _mrqxvbij8b9u]Import from Layer
· Layer drop down menu: Select an existing layer from the drop down menu that you would like to use as the base for your new layer.
· District Field: Select the column title for the district assignment from the drop down menu
· Minimum Overlap %: You can choose the minimum percentage a block must be within a district to be assigned to that district. The default is set at 60 per cent (i.e. if 60 percent of a block is within District A, it will be assigned to District A). You can change this percentage by editing the input box but can not make the minimum below 50 percent. Any blocks that do not get assigned to a district will need to be manually assigned to the appropriate district. Higher minimum percentages will allow for more control over block assignments, but also require more assigned blocks. 
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[bookmark: _murd67obp01h]Import Equivalency File
· Browse: Browse will open up a File Explorer window with the GIS DataBase folder. You can select any file (.txt or .csv) from your computer to use.
· Block ID Field: Select the field  from your equivalency file that contains the Block IDs for each census block 
· District Field: Select the field from your equivalency file that contains the district assignment for the census block
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[bookmark: _jhevvmcxbbb2]

[bookmark: _wyzmc7761itc]Plan Analysis
Users can check their redistricting plan using find discontiguous areas and unassigned areas. 
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[bookmark: _q6duwlgmbcoa]Find Discontiguous Areas
This will locate areas within a district that are discontiguous from the rest of their district. You can use the triangle button icons to move up and down through the list of areas, and the map will recenter the map to the area as well as outline the discontiguous area. 
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[bookmark: _sppn693qopo6]
[bookmark: _wghfj43cgypx]

[bookmark: _5rt8ysnnxxki]Find Unassigned Areas
This will locate any areas that are currently unassigned to any district. You can use the triangle button icons to move up and down through the list of areas, and the map will recenter the map to the area as well as outline the unassigned area.
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[bookmark: _scmy85z7v7ss]Imagery
You can turn on the background imagery on the map, including street view imagery of roads, buildings, and natural features by single clicking on “Imagery” in the Draw My CA drop down menu.  Once turned on, an Esri Imagery layer will be added to the Layers panel under the basemap layer called “High Resolution 30cm Imagery”.
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[bookmark: _wav5jos7832s]Print Plan
Once you have completed your district plan, you can print the plan to a PDF to show others your work. There are four different built-in map printing options. 
· District Landscape: print a map with a district in the plan in a landscape view (horizontal). 
· District Portrait: Print a map with a district in the plan in a portrait view (vertical). 
· Atlas Landscape: Print a series of maps with each district in the plan in a landscape view 
· Atlas Portrait: Print a series of maps with each district in the plan in a portrait view 
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Users can also create their own printing layout in QGIS with their preferred map items and layout by Project → New Print Layout.
[bookmark: _n3u6fqjtzk9]Web Service Connect
This will open up the User Connect window. You can change your session to Offline or Connect to the server. You can also change accounts through signing into a different account here. 
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[bookmark: _7qlhelwtbpl9]Export
You can export your plans to files on the local drive for the computer on which you are working. First, select which layer you would like to export from the Layer drop down menu. Then, you can select which file structure(s) you would like (CSV, XLSX, Shapefile). Once you are satisfied with your plan, you can also check the box to directly export it to the Commission.
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[bookmark: _9536zof70hrr]Panels
There are different panels in the QGIS workspace. You can rearrange the panels by clicking and dragging them to a different location in the QGIS window or to a different area of your computer's screen as a pop up window. You can also close them at any time using the “x” in the top right corner of the panel. Right click on any panel to see a list of all panels and check/uncheck the ones you wish to display.

[image: ]


[bookmark: _12lllvpfr647]Layers Panel
You can turn on or off any of the layers through checking or unchecking the box in the list. 
· Plan Layers
· By double clicking on the layer, the Layer Properties window will open. Here you can adjust the display colors and styling. 
· Basemap
· This is the layer which all the districts are mapped onto. The basemap by default shows “linear features”, Federally recognized American Indian Areas (both Reservation and Off-reservation Trust Land), County outlines, and water areas (ocean, rivers, and lakes). To show additional features or to remove any of these features, check/uncheck the boxes next to the appropriate feature. You can also change the feature’s display attributes (color, fill in type, thickness, etc) by double clicking on the feature you would like to adjust. 
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